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Critical to the success of community coalitions is the process of selecting, tracking, and reporting on
indicators of progress and outcome. Groups that take the time to define what success looks like--- both
the end result and the signposts along the way— save valuable resources and increase impact. A
coalition with a high-performance measurement culture is committed to a data-driven process that
builds accountability, trust, and cross-sector engagement.
The CHIA Sample Dashboard for Measuring the Progress and Impact of Alcohol-Related Initiatives was
developed by Community Health Improvement in Action (CHIA) as a resource to help communities
organize and present data in a way that is easy to read, track, and understand. The Dashboard serves
not only as a tracking and reporting mechanism, but also as a training in presenting data effectively in
Microsoft Excel. Charts and tables follow best practices for visualizing data, and detailed instructions
make it easy for users to adapt the dashboard to fit local needs.
Intended for use by coalitions and agencies working to improve the health of their communities, the CHIA
Sample Dashboard is a template that can be used for any health focus area and with any indicators. As
the CHIA project uses alcohol misuse as the stage on which to practice skills in implementation and
evaluation, the CHIA Sample Dashboard is alcohol-focused. The dashboard presents a limited number of
SAMPLE alcohol-related indicators that were selected by a committee of subject matter experts (see
Acknowledgements).
Prior to developing a dashboard for your community, we urge you to choose the indicators that best
represent your coalition’s mission, local conditions, and efforts. Creating a logic model for coalition work
(or a strategy map or theory of change) is essential in selecting appropriate indicators to track. Good
measures of progress and impact vary by coalition. The right indicators will provide your coalition with
the information you need to make decisions and take efficient and impactful action. Indicator selection
is beyond the scope of this User Guide. For a comprehensive overview of alcohol-related strategies and
indicators, as well as sample local strategy maps, please see the CHIA Strategy Map for Preventing and
Reducing Alcohol Misuse, available on the CHIA Resources page under the Alcohol-Related Resources
tab at www.wicommunityhealth.org.
In addition to this User Guide, video tutorials are available to introduce you to the CHIA
Dashboard. Watch them at www.wicommunityhealth.org (on the CHIA Resources page
under the Alcohol-Related Resources tab).
Community Health Improvement in Action (2014-2017) is a project of the Wisconsin Association
of Local Health Departments and Boards and is funded by a grant from the University of
Wisconsin School of Medicine and Public Health through the Wisconsin Partnership Program.
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Please attribute CHIA in all versions of the dashboard you create; see Suggested Citation section.

An Overview of the Dashboard Tabs
The CHIA Sample Dashboard is an Excel file with multiple inter-related tabs. Here is a summary of the
tabs and how they are interconnected:


The Introduction tab offers a brief description of the dashboard and refers users to this guide.



The Report tab provides a template for presenting an overview of findings. To maximize reader
attention and understanding, the report uses best practices of visual processing theory, such as
clean lines, intentional use of color, and easy-to-interpret charts. You may print this report as a
2-page pdf. First, you will need to input your data (on the data source tabs for YRBS, BRFSS, Epi
Report, and Outlet Density) and prepare your charts on the Tables & Charts tab.
The charts on the main body of the Report tab (shown in red boxes in the figure below) pull data
from the Tables & Charts tab.



The Tables & Charts tab is where the charts for the Dashboard Report are created. Data from the
charts on the Tables & Charts tab are automatically updated on the Report tab. (However, some
chart elements, like titles, will need to be revised individually on both the Report and Tables
tabs.)
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Why is the Tables & Charts tab needed? Many of the charts on the Dashboard Report use
benchmark lines that require special formatting. That’s why the tables on this tab have extra
shaded gray cells, as shown below.

Don’t input data on the Tables & Charts tab. Cells on this tab pull information from the data
source tabs (YRBS, BRFSS, Epi Report, and Outlet Density). Once your data has been entered on
the related data source tabs, you’ll visit the Tables & Charts tab to make minor revisions and
create new chart titles.


There are six data source tabs:
o

YRBS (Youth Risk Behavior Survey)

o

Binge Drinkers BRFSS (Behavioral Risk Factor Surveillance System)

o

Arrests Epi Report (Wisconsin Epidemiological Profile on Alcohol and Other Drug Use)

o

Hospitalizations Epi Report (Wisconsin Epidemiological Profile on Alcohol and Other Drug
Use)

o

Outlet Density

o

DFC (Drug-Free Communities) or STOP Act (Sober Truth on Preventing Underage Drinking
Act)

Each data source tab provides a spreadsheet for entering your data that also functions as a
dashboard for reporting on progress (as depicted below). Data from the data source tabs feed
into the Tables & Charts tab and then are reflected in the Report tab.
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As shown in the example below, each data source tab includes a dashboard that helps you quickly
visualize key elements of your progress, such as completion of coalition objectives (shown with check
marks), trend/sparklines, and comparisons to state and national averages (red dots indicate local data is
worse for this measure) .

General Tips for Dashboard Use
To fully use the dashboard, it’s helpful to have a basic understanding of Excel. Excel Easy is one free
website for Excel tutorials: http://www.excel-easy.com/. In addition, Flinders University provides a pdf
overview of Excel 2013: https://www.flinders.edu.au/staff-developmentfiles/computer/Excel%202013%20-%20Intro.pdf
The instructions we provide here use Excel 2013. If you have a different version of Excel, you
may need to search online for how to complete a specific step using your version.
As outlined in the section above, the order of the tabs on the Excel dashboard begins with the Report and
ends with data source tabs. However, you’ll want to proceed as directed in this User Guide: start by
entering your data in the data source tabs, then prepare your charts in the Tables & Charts tab, and
finally put the finishing touches on your Report.
As you enter your data and adapt the dashboard to fit your local needs, we recommend you periodically
use the “Save As” function to create a new version of the document. This way, you can revert to an
earlier version if needed. If you make a mistake, “undo” the action (Ctrl-Z). If you mistakenly undo a
step, “redo” it (Ctrl-Y).

6

We hope you enjoy the Dashboard and welcome your questions and feedback: visit
www.WICommunityHealth.org; contact Sara Jesse, CHIA Project Manager, at sara.jesse@badgerbay.co or
608-432-3042; or contact WALHDAB at WALHDAB@badgerbay.co or 920-560-5635.
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Data Source Tabs: YRBS, BRFSS, Epi Report, Outlet Density, and DFC or STOP Act
The CHIA Sample Dashboard has multiple data source tabs: YRBS, Binge Drinkers BRFSS, Arrests Epi
Report, Hospitalizations Epi Report, Outlet Density, and DFC or STOP Act. Essentially, the layout for each
data source tab is the same, so instructions for entering your data are very similar across all data source
tabs. We recommend you proceed with the instructions below one tab at a time, focusing on the details
that are relevant to that tab.
There are ten basic steps to entering your data, outlined below. Once you take these steps, if you’d like
to try more advanced and optional data entry steps, see these entries in the Optional Customizations
section, hyperlinked below:







Enter More Recent Statewide and National Benchmark Data
Add More Columns of Local Data
Adjust the Data Range of Trend/Sparklines
Have New Rows in the “Tables & Charts” Tab Self-Populate with Data from a Data Source Tab
Adjust Elements of Trend/Sparklines, such as Axis Settings
Change or Add Conditional Formatting Rules:
 Checkmark Rule
 Red Dot Rules for Comparing Local Data to State and National Figures
 Pink and Red Dot Rules for Rank in State on the Outlet Density Tab

10 Basic Steps to Enter Your Data:
1) Review each indicator in Column A, making sure you understand it and its data source fully. (See
the About the Data Sources section for information.)


The setup of indicators on the Outlet Density tab is different from the other data source
tabs. Geographic areas are listed in Column A. The main indicators on this tab are
People per License (represented in Columns O through W) and Licenses per 500 People
(in Columns X through AD). See figure below.

All cells with a small red triangle in the upper right corner have comments associated with them.
Hover over one of these cells to see its comment pop up (the light pink shaded box below).
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Read each indicator’s comment. To see the comment, hover over the indicator cell (in Column A for
all data source tabs except Outlet Density). The comment explains if, for the purposes of this
dashboard, a bigger number is “better” or “worse” for this indicator. This is important because it
determines both of these dashboard elements:


The direction of the coalition’s objective for the indicator: Are we trying to increase or
decrease this number? Objectives are included on the YRBS, BRFSS, Hospitalizations,
and DFC tabs.



The comparison of local data to state and national figures: Red dots, automatically
generated on the data source tabs, mean that local data for a given indicator is “worse”
than state or national data. You should know if “worse” means a higher or lower number
for each indicator.
Note: for the Arrest Epi Report tab, you may not agree that a higher rate of arrests is
worse, as indicated on the dashboard with a red dot for local arrest rates higher than
state or national averages. You must talk to law enforcement to correctly interpret trend
and comparison data for arrests. More Operating While Intoxicated (OWI) and liquor law
arrests could be due to an increase in the problem (a bigger number would be “worse”) or
an increase in enforcement (a bigger number might be considered “better” if the objective
is to increase enforcement).

In the figure below, we’ve hovered over Cell A4, Youth Current Drinkers, on the YRBS tab to show the
comment. A bigger number is worse for this indicator, so the coalition objective is to “Decrease to”
a specific number, 30%, by a specific date, 12/31/18 (Cells B4, C4, and D4 respectively). When the
objective is met by the most recent data point (here, 2015) in Cell O4, a checkmark will be
automatically generated in Cell E4. The Youth Current Drinkers percentage for 2015 was 31, so the
checkmark is not present. A red dot will be automatically generated in Cells R4 and S4 if the same
year of local data (in hidden Cell Q4) is worse (higher) than state and national figures. In the
example below, local rates are not worse (higher) than state and national ones for the same year, so
no red dots are generated for Rows 4 and 5.
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For the YRBS, BRFSS, and DFC tabs, note that comments on Column A also include the survey
question used and how to calculate the measure.


On the YRBS tab, especially note that the indicators for “Youth who get alcohol from
social sources” and “Youth who get alcohol from retail sources” use calculations made
from all students who answered the question (not just the students who reported drinking
alcohol in the last 30 days). This is so you can see progress on these indicators.

2) Make sure each indicator you track is relevant to your coalition’s mission and efforts. Your
coalition’s action plan and logic model will help you determine the relevance of an indicator to your
work. For an overview of alcohol-related strategies and related indicators, as well as sample local
strategy maps, please see the CHIA Strategy Map for Preventing and Reducing Alcohol Misuse,
available on the CHIA Resources page under the Alcohol-Related Resources tab at
www.wicommunityhealth.org.
3) If needed, change your indicators and/or the name of the tab. As a template, indicators and tab
names on the CHIA Sample Dashboard can be easily changed:


To change the tab name, right click on the tab (on the bottom of the screen) and select
“Rename.” (Or double click on the tab.) Type the new name and press Enter. Change the
title of the tab (Cell A1) as well.



To change an indicator, click on the indicator cell you wish to change and type in your
indicator of choice. Remember to be aware of the direction of an indicator-- whether a
bigger number is better or worse. Where possible, use an indicator that has the same
direction as on the template so as not to have to change the conditional formatting rules
that create checkmarks and red and/or pink dots. If you must change the direction of an
indicator, see the section on Changing Conditional Formatting Rules.

10



To edit or delete the comment associated with the indicator, right click on the cell and
choose Edit Comment or Delete Comment.



If there is no statewide and/or national data available for your new indicator and one was
given for the template indicator, write “na” in the appropriate column(s) on the data
source tab. Then go to the Tables & Charts tab and Clear Contents of the Statewide
Average cells for that indicator’s table. (Select cells, right click, then choose Clear
Contents.) Doing so will delete the statewide average benchmark line from your column
chart for this indicator. See example below.
On the Tables & Charts tab below, we went to the table for the indicator we wanted to
change and for which we don’t have state average data (depicted below is Youth Current
Drinkers). We’ve selected the cells that relate to the State Average: C22-C34 in this
example. To clear the contents of these cells, right click on this selection and choose
“Clear Contents” from the dropdown menu.

4) Access your data from the appropriate data sources, summarized here (see the section About the
Data Sources for more information).


YRBS: Visit the About the Data Sources section for tips on advocating for and accessing
local data from the Online YRBS. For the official Wisconsin (paper-based survey) YRBS
sample average (Column R), download the Summary Table at
http://dpi.wi.gov/sspw/yrbs. For the official national (paper-based survey) sample
average (Column S), visit: http://www.cdc.gov/healthyyouth/data/yrbs/index.htm.
PROCEED WITH CAUTION when comparing local (from online survey) YRBS data to state
and national sample averages (from the official paper-based survey of a representative
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sampling of high schools), as these survey methodologies are different.


Binge Drinkers BRFSS: Access binge drinking data from BRFSS via WISH (Wisconsin
Interactive Statistics on Health) query using the Trend Module:
https://www.dhs.wisconsin.gov/wish/brfs/form.htm. For county-level results:
o

Step 1: Choose a topic: binge drinking.

o

Step 2: Choose age-adjusted results (for a more accurate comparison of your
data with other geographic regions).

o

Step 3: Choose Geographic Areas as a column variable.

o

Step 4: Choose Survey Years. IMPORTANT: For results of less-populated counties,
you must select multiple years of data (hold down the control key and select the
desired years). All counties in Wisconsin are represented in query results when 3
years -- e.g., 2014, 2013 and 2012-- are all selected. For more populous counties,
data may be available annually or in two-year periods. Experiment to get the best
data for your area. The BRFSS tab has 9 columns available for entering local data
(Columns F through N, with most of these hidden; see below for instructions for
unhiding columns).
Note that starting with 2011, BRFSS began including both landline and cell phone
interviews, obtained from separate samples and later combined and weighted by
the U.S. Centers for Disease Control and Prevention (CDC). Prior to 2011, only
landline telephone numbers were sampled. Estimates using combined landline
and cell phone BRFSS data from 2011 and forward should not be directly
compared to estimates from earlier years when only landlines were used.

o

Step 5: Choose a Geographic Area.


For local data, select "County" and then choose one or more counties. (Or
select “Milwaukee” and then choose city and/or surrounding area.)



Select "Statewide" for the Wisconsin average.

Source of National BRFSS data: by query at http://www.cdc.gov/brfss/brfssprevalence/.
You must calculate the US average (click on cell Q4 to see the formula).


Arrests Epi Report: Access arrest data from the Wisconsin Epidemiological Profile on
Alcohol and Other Drug Use ("Epi Report"), 2016, 2014, 2012, 2010, and 2008.
Available at: https://www.dhs.wisconsin.gov/stats/aoda.htm.
o

For county and state rates, see Table: Operating a motor vehicle while intoxicated
(OWI) and liquor law arrests, rate per 100,000 population, Wisconsin by county.
12

More recent data may be available from local law enforcement agencies and/or
Arrests in Wisconsin, an annual report by the Wisconsin Department of Justice:
https://wilenet.org/html/justice-programs/programs/justice-stats/library.htm
with population data from Wisconsin Interactive Statistics on Health (WISH)
population module: https://www.dhs.wisconsin.gov/wish/population/index.htm.
Again, it is important to talk to local law enforcement leaders about how to
interpret changes in arrest rates. A lower arrest rate could be caused by less
problem behavior or less enforcement, for example.
o

o

For national rates, see Figure 10. Arrests (adult and juvenile) for operating a
motor vehicle while intoxicated (OWI), rate per 100,000 population, Wisconsin
and the U.S. and Figure 11. Liquor law arrests (adult and juvenile), rate per
100,000 population, Wisconsin and the U.S.

Hospitalizations Epi Report tab: Access local and state alcohol-related hospitalization
rates from the Wisconsin Epidemiological Profile on Alcohol and Other Drug Use ("Epi
Report"), 2016, 2014, 2012, 2010, and 2008; Table: Alcohol-related hospitalizations,
total number and rate per 100,000 population, Wisconsin by County. Epi Reports
available at: https://www.dhs.wisconsin.gov/stats/aoda.htm.
If you want more recent data, you will need to calculate local and state estimates
according to the methods used by the Epi Report using (1) the Wisconsin hospital
inpatient discharge database (Office of Health Informatics, Division of Public Health,
Wisconsin Department of Health Services) and 2) Alcohol-Related Disease Impact (ARDI)
specifications from the CDC (https://nccd.cdc.gov/DPH_ARDI/default/default.aspx). For
details on methods, see the 2016 Epi Report, p.112 (Appendix 2: Data Sources, Other
Data Sources for this Report, Estimating Alcohol-Related Hospitalizations).

o

Outlet Density tab: Municipal clerks annually report the number of alcohol licenses to the
Wisconsin Department of Revenue (DOR). The Outlet Density tab uses four main data
sources: local DOR data, as reported in county-specific 2012 Density Reports;
compilations of local DOR 2015-6 licensing data maintained by Julia Sherman of the
Wisconsin Alcohol Policy Project; population estimates from the Wisconsin Department of
Administration, Demographic Services Center; and state and national licensing
information from the Fact Book 2013 (The Beverage Information Group). Due to
differences in how DOR data was compiled, there may be discrepancies between the
2012 Density Reports and more recent data. Be careful about comparing local data to
national figures: since every state licenses alcohol differently, national figures and
comparisons across states can be problematic.
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Download the 2012 Alcohol License Overview for your county, available at:
https://www.dhs.wisconsin.gov/aoda/alcdensity.htm. Also known as Wisconsin
County Alcohol Outlet Density Reports, and here referred to as “Density Reports,”
these publications were a joint project of the Wisconsin Department of Health
Services and the Wisconsin Alcohol Policy Project. As of March, 2017, there are
no plans to publish reports in this format in 2017.
To ease data entry using your county’s 2012 Density Report pdf, consider
decrypting the pdf so you can cut and paste data. Adobe Acrobat is a good tool
for decryption, but there are also free apps, such as PDFill free PDF Tools,
available for download at: https://www.pdfill.com/pdf_tools_free.html. Note that
if you are copying and pasting data from the Density Report, it is helpful to make
use of your Clipboard: it’s possible to cut several data items, one at a time, from
the Density Report, and then paste them, one at a time, to the Dashboard Outlet
Density tab.
Use data from the following tables in the Density Report:
 Table 4, County Overview: for county population (for 2007 in B8 and for
2011 in C8) and licenses issued (for 2007-2008 in G8 and for 2011-12 in
H8). Note that People per License for these years (Columns N and O)
contain a formula for automatically computing each cell: = Population/
Licenses.
 Table 5: County People/License and Rank within the State: for Cell U8,
Rank in State (2011-12).
 Use only if more recent data is not available: Table 8: Licenses Issued by
License Type for Cells L8 and M8: Class A and B Licenses Issued in 20112012.
Note: The number of licenses by type (A and B) will not always add up to
the total number of establishments issued licenses (“licenses issued”) due
to reporting omissions, establishments that receive more than one license
type, and outlets that are issued a class C license only (Class C licenses
are for restaurants who qualify, for the sale of wine. They are included in
the total number of licenses issued).
 Table 10: Municipalities Not Issuing Alcohol Licenses by Year: note these
in the text box under the table on the Outlet Density tab.
 Table 11: Municipality Licenses/500 People Rank within County and
State, will supply the data for municipalities that issue licenses in your
county: Population in 2007 and 2011 (Columns B and C); Licenses Issued
in 2007-08 and 2011-12 (Columns G and H); and Rank in State 2011-12
14

(Column U).
If more recent data is available to you, we suggest you use that
information for Columns L and M (Class A and Class B Licenses Issued).
Input this data from the 2012 Density Report Table 11 ONLY if 2015-16
data is not available to you.
o

For more recent data (Columns I, L and M), you can obtain an Excel spreadsheet
that lists the 2015-16 licensees in your county by municipality from Julia
Sherman, coordinator of the Wisconsin Alcohol Policy Project: 608-262-0370 or
julia.sherman@wisc.edu. Otherwise, you can obtain this information locally,
although you will likely have to ask each municipality in your county separately.
Note: When processing information on licenses, count Class A, B, and C licenses
using the following key:
 Class A licenses include:
 AB = Class "A" beer (off-sale): convenience/grocery stores
 AL = "Class A" liquor (off-sale): drug stores, wineries
 ALB = Class A beer/Class A liquor (includes wine); off-sale only
 Class B licenses include:
 BB = Class "B" beer only (on/off sales) or in combination with "Class
C" wine
 BLB = Class "B" beer and "Class B" liquor (taverns, supper clubs, etc.)
 BL = Class "B" Liquor Only (winery)
 Class C licenses:
 CW = "Class C" wine (on-sale): restaurants who qualify
Since licenses for WB (Wholesale beer) and WAB (Wholesale beer distributor and
Class "A" beer) are regulated by the state, you need not include them in your
counts.

o

Enter 2015 population estimates in Column D. The Wisconsin Department of
Administration, Demographic Services Center annually produces population
estimates for Wisconsin counties and municipalities, available at
http://www.doa.wi.gov/divisions/intergovernmental-relations/demographic-servicescenter/estimates.


For municipal data, download in Excel format “Municipality Final
Population Estimates, Alphabetical List” under the heading January 1,
2016 Final Population Estimates.
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For ease of data entry, first "sort and filter" Column E (County) on the
Municipality Final Population Estimates spreadsheet. To do so, select
cells E4 through E1854. Then click on Sort & Filter on the Home tab of
Excel and select "Sort A to Z" on the dropdown menu. Select "Expand the
selection" and then "Sort" on the window that pops up. Now all
municipalities are grouped by county, except for the municipalities in
multiple counties. Remember that some municipalities may not have
issued alcohol licenses: note their 2015 population in the Notes section
under the table on the Outlet Density tab).

o





For county population, download in Excel format “County Final Population
Estimates" under the heading January 1, 2016 Final Population
Estimates.



For municipalities in multiple counties, download in Excel format "Final
Population Estimates for Municipalities in Multiple Counties." Use the
search feature (Control-f) to find municipalities in your county.

State and national data on People per License (Columns V and W) and Licenses per
500 Population (Columns AC and AD): alcohol license counts are reported in The Fact
Book 2013 from The Beverage Information Group (2013), pages 12-13; population
data is based on U.S. Census Bureau estimates for 2013. More recent figures may
be available, as the Fact Book is an annual publication. The 2016 Fact Book costs
$525. Again, since every state licenses alcohol differently, national figures and
comparisons across states can be problematic.

DFC or STOP Act Tab: The first risk factor listed here, Youth 30 Day Use in Row 4, pulls
data from the YRBS tab (including in hidden Columns I-N), so enter this data in the YRBS
tab first and it will auto-populate here. Note that column headers (for year of data point)
are not pulled from the YRBS tab and therefore may need to be adjusted. For all other
DFC or STOP Act indicators, you will need to enter the data manually from your data
sources.

5) For YRBS, BRFSS, Epi Report Hospitalizations, and DFC tabs: Choose an objective for each indicator
(as appropriate to your coalition’s efforts) and enter each number in Column C.
Unless necessary, do not change the direction of the objective in Column B (e.g., from “decrease” to
“increase”), as this will affect the conditional formatting rules used to generate check marks in
Column E and red dots in columns comparing local data to state and national rates. If you must
change the direction of Column B, see the section on Changing Conditional Formatting Rules.
As depicted below on the YRBS tab, conditional formatting rules automatically generate a check
mark in Column E if your objective has been met for that indicator. Columns R and S use conditional
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formatting to automatically generate a red dot if your local data for that year is worse than state or
national figures. All these rules depend on the direction of your objective in Column B to indicate if a
bigger number is “better” or “worse.” So don’t change the direction of the indicator’s objective or
you’ll need to change the conditional formatting rules as well.

6) Unhide all hidden columns on the table. Scanning the column headers on each data source tab,
you’ll notice that there are hidden columns. For example, on the YRBS tab depicted above, Column
H is followed by Column O with double lines between them, indicating that Columns I-N are hidden.
To unhide columns, select the columns before and after the hidden ones (in our YRBS example,
Columns H and O). Do this by selecting column headers H and O all the way at the top of the
spreadsheet, right click, then select Unhide from the dropdown menu. You’ll see this changes the
sparklines on the table, but don’t worry. Later, you can hide any unused columns and the sparklines
will adjust accordingly. The columns that are hidden vary by data source tab:


On the YRBS and DFC tabs, Columns I-N are hidden between Columns H and O. Column
Q is hidden between Columns P and R.



On the Binge Drinkers BRFSS tab, Columns G-M are hidden between Columns F and N.



On the Arrests Epi Report tab, Columns K-M are hidden between Columns J and N.
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On the Hospitalizations Epi Report tab, Columns O-Q are hidden between Columns N and
R.



On the Outlet Density tab, several groups of columns and rows are hidden: Columns E
and F are hidden between Columns D and G; Columns J and K are hidden between
Columns I and L; Columns R and S are hidden between Columns Q and T; Columns AA
and AB are hidden between Columns Z and AC; and Rows 27-65 are hidden between
Rows 26 and 66. To unhide all columns at once, select Columns A through V, right click,
and then select Unhide. To Unhide rows, select Rows 26-66 (do this by clicking on the 26
and 66 headers all the way to the left of the spreadsheet), right click, then select Unhide.
You’ll see this generates lots of error messages in Columns Q-S and that it changes the
sparklines, but this is okay. Later, you can hide any unused columns and all will be
restored to order.

To unhide all columns at once on the YRBS tab, select H through R and choose Unhide from the
dropdown menu.

With all columns now unhidden, it’s time to enter your local data.

As explained in step 7 below, enter local data in the appropriate columns (here above on the YRBS
tab, Columns F-O, shown in the red box). Keep the most recent year in the last column of local data
(Column O in the example above).
18

7) Next, enter your local data in chronological order in the appropriate columns, changing the year in
the heading as needed. You must keep your most recent local data in the last column for local data
because the conditional formatting rules used to generate checkmarks and red dots depend on the
value in this last column of local data.
Before entering your most recent data point: If you want to keep the data that currently exists in the
last column of local data, manually transfer it to another column designated for local data. You can
NOT use the usual cut and paste because this would change the conditional formatting rules. Then
manually enter your most recent data in the last column of local data. The conditional formatting
rules for checkmarks and dots will remain the same.
If you are adding other data points, you can use any of the other columns designated for local data.
These columns are not specially formatted; you can cut and paste to your heart’s content within
these columns.
Local data columns by tab:


YRBS and DFC tabs: enter most recent data in Column O. Use any Column F-N for all
other local data points.



Binge Drinkers BRFSS and Arrests Epi Report tabs: enter most recent data in Column N.
Use any Column F-M for all other local data points.



Hospitalizations Epi Report tab: enter most recent data in Column R. Use any Column FQ for all other local data points.



Outlet Density tab: There is no need to keep the most recent data in a specific column on
this tab. Enter local data in Columns A-M. (In Columns L and M, breakdown the number
of Class A and Class B licenses for the most recent year available.) The remainder of the
local data columns on this tab contain formulas that will auto-populate for you: People
per License and Licenses per 500 Population. Note that the rules used to generate red
and pink dots in Column U are fixed: they do not depend on data in any other column. For
more information, see the section on Pink and red dot rules for rank in state on the Outlet
Density tab.

In the example below, we added 2017 local data to the YRBS tab in Column O. Before doing so, we
manually transferred the 2015 data that used to be in Column O to Column I. As directed in step 8
below, we will next hide Columns J-N again by selecting them, right clicking, and selecting Hide.
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8) Hide any unused columns of local data: click on the blank columns you want to hide (select the
header letter(s) of the column(s) all the way at the top of the spreadsheet, as shown in the example
above), right click, and then select Hide. Your Trend/Sparklines will return to normal.
9) Information entered on the data source tabs are linked to cells on the Tables & Charts tab. Go to
the Tables & Charts tab. Notice that on each table on the Tables & Charts tab, there are hidden
rows. For example, on the first YRBS table on the Tables & Charts tab, Youth Current Drinkers, rows
26-31 are hidden. To Unhide rows, select rows before and after the hidden ones. (Select Rows 25
and 32 in this example; do this by clicking on the headers 25 and 32 all the way to the left of the
spreadsheet). Once selected, right click, and then select Unhide from the dropdown menu. You’ll
see this changes the column chart to the right, but don’t be concerned. Later, you can hide any
unused rows and the chart will adjust accordingly. Unhide the rows for all of the tables on the Tables
& Charts tab that are associated with the data source tab you are working on. (There are 4 tables on
the Tables & Charts tab that are associated with data on the YRBS tab; 2 tables associated with the
Arrests Epi Report tab, and 1 table associated with each tab for Binge Drinkers, Hospitalizations,
and Outlet Density.)
Below, we will Unhide rows 27-32 on the Youth Current Drinkers table.

Now unhidden, note that YRBS data for 2015 has self-populated in row 27. All unused local data
columns on the YRBS tab (J-N in our example) populate here with zeros in rows 28-32. As directed
in step 10 below, we’ll hide them again: select rows 28-32 and select Hide.
20

10) Still on the Tables & Charts tab, note that the rows have self-populated with the data you entered on
the data source tab. Now re-hide any unused rows that are populated with zeros: click on the rows
you want to hide (select the header number(s) of the row(s) all the way to the left of the
spreadsheet), right click, and then select Hide. Your column charts will adjust to the data that is
shown (that is, not hidden).
Return to the data source tab you were working on to complete any of the Optional Steps for Customizing
Data Source Tabs.

The Tables & Charts tab is where charts with benchmark lines are generated. The tables on this tab are
specially formatted to create charts with nice long benchmark lines. We have tried to make the charts
as easy for viewers to interpret as possible by incorporating best practices of visual processing theory,
such as clean lines, intentional use of color, and a one-sentence descriptive title.
Do not enter data on the Tables & Charts tab. This tab pulls data from the data source tabs (YRBS, Binge
Drinkers BRFSS, Arrests Epi Report, Hospitalizations Epi Report, and Outlet Density). Unless you prefer
to enter data twice (here and on the data source tab), do not enter data on the Tables & Charts tab.
Instead, follow the link for "Data Entry" next to each table to enter your data on the appropriate data
source tab, following the steps for data entry in the previous section, Step 1: Enter Your Data. Note that
the data entry instructions include steps for unhiding and rehiding rows of data in the tables on this
Tables & Charts tab.
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Once your data has been entered, you will need to change chart titles to accurately reflect your data. To
do so, simply click on the text box in the title area of the chart and edit the text. Best practice for chart
titles: rather than a heading, such as "Binge Drinkers," chart titles should be a one-sentence description
of the data. For more on this topic, see http://stephanieevergreen.com/how-to-rock-the-text-in-your-datavisualization/.
Shaded cells on the tables are intentionally left blank; do not delete these rows. The blank cells are
needed to create longer state and national benchmark lines that extend beyond the columns of local
data on the charts. For more on how to create a benchmark line in Excel, see instructions below in the
section To make new charts in this style, or visit: http://stephanieevergreen.com/adding-a-benchmarkline/.
The tables on this tab are used to make the charts on the Report tab. When you make changes to the
charts on the Tables & Charts tab, the Report tab should update automatically with the revisions, except
for the text boxes, including chart titles. Please check both tabs to make sure all chart elements are
correct, especially chart titles and other text boxes. Note: for titles, the charts use text boxes instead of
title boxes because, due to a quirk in Excel 2013, title boxes cannot be resized or moved.
You may also copy and paste charts on the Tables & Charts tab to other documents in Word, Excel,
PowerPoint, etc.
To add new charts, format charts, or further customize the Tables & Charts tab to meet your needs, see
the section Optional: Create a New Chart on the Tables & Charts Tab.

The Report tab provides a template for presenting an overview of findings. To maximize reader attention
and understanding, the report uses best practices of visual processing theory, such as clean lines,
intentional use of color, and easy-to-interpret charts. The charts on the Report tab pull data from the
Tables & Charts tab. To avoid duplication of efforts, please review the previous section, Step 2: Prepare
Your Charts on the “Tables & Charts” Tab, before changing the charts on the Report tab. Provided below
is a style guide and instructions on the specific elements of the Dashboard Report that you’ll need to
change.

Style Guide: for reference when working on the Dashboard Report


Note the green file folder shapes at the top of each page of the report are made up of several
overlapping shapes, as design formatting options are limited in Excel. The green color used has
an RGB of Red: 195; Green: 233, and Blue: 145. [To select this color, select the shape, then go to
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the Format tab and choose Shape Fill (circled in red in the example below). Choose More Colors
from the initial color palette, then input the RGB code on the Custom tab. See diagram below.)



The burnt orange color has an RGB of 190, 81, 8.



The nickel gray color’s RGB code: 114, 114, 114.



The straw color used for the columns of data: 223, 204, 116



The darker Aztec gold/brown color: 203, 144, 77



Fonts: We use Candara for the Dashboard Report title and side bar, and Corbel for chart
elements, including titles. Note: The CHIA Dashboard uses these fonts because they are nice
looking sans serif fonts that come standard with all versions of Microsoft Office. However, we
strongly recommend an alternate condensed font for use on your charts, such as Franklin Gothic
Condensed (available for free download online at http://fontsgeek.com/fonts/Franklin-GothicStd-Condensed: click on ZIP download, then open the downloaded file and click on Install). If you
choose a different font, stay away from Arial or Calibri, as these are overused and can make your
work look boring.
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Chart titles use a 12 point font, with the data source listed below the title in a 10 point font.



Chart data labels are in 10.5 font. X-axis (years) are in 10 point font.

5 Steps to a Personalized Dashboard Report for Your Community
1. Change the title of the Dashboard Report. You could simply replace ABCDEFG with your
geographic area, or create an entirely new title. You may want to add your logo: we suggest using
the space on the right sidebar, moving the sidebar graphic up or down as needed.
2. Edit the estimated cost of excessive alcohol use in the green file folder shape at the top of the
report. Enter the estimated cost to your geographic area (e.g., $16.7 million) from the Burden of
Excessive Alcohol Use in Wisconsin report. Change ABCDEFG to your geographic area. To
download the data: https://law.wisc.edu/wapp/burden_of_alcohol.html.
3. Review all charts to ensure that all their elements are correct and placed appropriately, including
titles, labels, and any shapes that were added (such as the arrow and text box on the chart
depicting sources of alcohol for youth). Note that text boxes (including titles) do not
automatically update when changes to them are made on the Tables & Charts tab. You may also
need to adjust the placement of labels, text boxes, and plot area: for more on this, see Simplify
the Chart’s Look section in the instructions for the Tables & Charts tab.
4. Edit the sidebar on arrests data on the first page of the report. Calculations are available to help
you compare your local rate to state and national figures: see the rows under the two tables for
arrest data on the Tables & Charts tab.
5. Edit the sidebar icon array on the second page of the report. Calculate how many youth should
be depicted and in what colors. Use burnt orange color as the action color (e.g., for 1 in 5, the 1
would be orange and the other 4 gray.)

You may need to add additional youth icons, or even a half/third/quarter icon. Several icons in
both colors are provided-- to the right of the Dashboard Report and depicted above-- for you to
cut, copy, and paste. You can also crop an icon: select the image, right click, and choose Crop to
create a half/third/quarter student.
You may print this report as a 2-page pdf. When printing, you will need to create custom margins (menu
option is circled in red below: 0 for top, bottom, left, and right).
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Before proceeding with more detailed customizations of data source tabs, complete the 10 Basic Steps
to Enter Your Data. Outlined below are additional steps you may want to take to adapt the dashboard to
your needs:







Enter More Recent Statewide and National Benchmark Data
Add More Columns of Local Data
Adjust the Data Range of Trend/Sparklines
Have New Rows in the “Tables & Charts” Tab Self-Populate with Data from a Data Source Tab
Adjust Elements of Trend/Sparklines, such as Axis Settings
Change or Add Conditional Formatting Rules:
 Checkmark Rule
 Red Dot Rules for Comparing Local Data to State and National Figures
 Pink and Red Dot Rules for Rank in State on the Outlet Density Tab

Enter More Recent Statewide and National Benchmark Data
Enter this data in the current column(s) for statewide and national figures, where available. Remember
to change the year on the heading for each column. You will not be saving the old state and national
benchmark data on this table; it will be deleted. (If you want to track statewide and/or national
benchmark data over time, please create an additional table.)
Cells in the columns for state and national figures use conditional formatting to generate a red dot if
local data for the same year is worse than the benchmark data. To avoid changing the conditional
formatting rules, manually enter the local data that is to be compared to state and national benchmarks,
rather than cutting and pasting. Depending on the data source tab, local data (for the same year as
benchmark data) are in different columns:


YRBS and DFC tabs: Statewide data is in Column R, National Data is in Column S, and local data
for the same year as benchmark data is in a hidden column, Q. (On the DFC tab, the first
indicator, Youth Current Drinkers, draws local, state, and national data from the YRBS tab. To the
best of our knowledge, state and national data are not available for the other DFC/STOP Act
indicators.) Since the benchmark year for the official paper-based YRBS may not be the same as
the most recent year of local Online YRBS data, it was not possible to link the red dot rule to a
column whose position would remain constant, so a hidden column, Q, was added. If you have
not already done so, Unhide Column Q: select Columns P and R (do this by clicking on the P and R
headers all the way at the top of the spreadsheet), right click, then select Unhide. Manually enter
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your data in Column Q. When you are finished, Hide Column Q again.


Binge Drinkers BRFSS and Arrests Epi Report tabs: Statewide data is in Column P, National Data
is in Column Q, and local data for the same year as benchmark data is in Column N. None of
these columns are hidden.



Hospitalizations Epi Report tab: Statewide data is in Column T and local data for the same year
as benchmark data is in Column R. None of these columns are hidden, and no national data is
available to the best of our knowledge.



Outlet Density tab: Rank in State data for People per License is in Column U. The conditional
formatting rule in this column depends on the value in Column U itself. (See Pink and Red Dot
Rules for Rank in State on the Outlet Density Tab.) Note that the Rank in State data was
compiled by 2012 Wisconsin County Alcohol Outlet Density Reports: Alcohol License Overview;
these reports may not be replicated in future years. Formulas for 2013 State and national
averages for People per License is in Columns V and W; formulas for Licenses per 500 People is
in Columns AC and AD. The source for 2013 state and national figures in Columns V, W, AC, and
AD: The Fact Book 2013 (The Beverage Information Group), pages 12-13. More recent state and
national data may be available. The Fact Book is an annual publication, but the 2016 edition
costs $525 to purchase: https://beverage-handbook-store.myshopify.com/products/2016-factbook?variant=12903981700

Add More Columns of Local Data
If additional columns of local data are needed, we suggest taking this step last, because adding columns
will change the names of the columns referred to in the steps of these instructions. (For example, if you
add one column of local data, what is called column Q in these instructions will now be R, R will be S,
etc.). Once you’ve inserted columns as instructed in this section, you’ll also need to follow the directions
to Adjust the Data Range of Trend Lines (Sparklines) and Have New Rows in the Tables & Charts Tab
Self-Populate with Data from a Data Source Tab.
New columns insert to the left of your selection. Select the heading of any column designated for local
data except the most recent data point. (Don’t select this or other special columns that are used in
conditional formatting rules.) Right click, then choose insert.
In the example below, we have annual data from the local online YRBS that we’ve collected since 2007,
so we need to add one more column of data. We’ll select Column F, right click, and choose insert.
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Enter your data in the new column(s). In our example depicted above, 2007 data would be entered in the
new (blank) Column F. The trend/sparklines may need to be revised to include your new column of data:
see the next section for instructions.

Adjust the Data Range of Trend Lines (Sparklines)
After adding a column of local data, you may need to adjust the data range represented in the
trend/sparklines. To do so, click on any trend/sparkline cell. Right click and, from the drop down menu,
select Sparklines, and then Edit Group Location and Data. In the Edit Sparklines window that pops up,
change the Data Range by selecting all of the data that should be displayed in your sparkline: select
every cell of local data (not including column headers or the sparkline column itself). Then select “OK” to
exit.
In the example below, when we inserted a new column of local data in the YRBS tab, we needed to adjust
the trend/sparklines to include the new column. In the Edit Sparklines window, for Data Range we
selected all the cells that contain local data, F4:P10.

Next, go to the Tables & Charts tab and insert rows for your newly added data point. New rows insert
above the selection, so select the row displaying the year after your new data point, right click, and then
choose Insert. You will need to do this for every table on the Tables & Charts tab that is associated with
the data source tab you are working on (4 for the YRBS tab, 2 for the Arrests Epi Report tab, and 1 each
for the BRFSS Binge Drinkers, Hospitalizations Epi Report, and Outlet Density).
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We added 2007 data on the YRBS tab. To add this row to the Youth Current Drinkers table on the Tables
& Charts tab, select Row 24, right click, and choose insert. Repeat for each of the four YRBS tables on
the Tables & Charts tab.

You may need to change the fill on the new row from shaded gray to no fill. To do so, select the row, and
then on the Home tab, select the paint bucket (fill) tool and choose “no fill.”
When you insert a new row in a table on the Tables & Charts tab, it will not automatically self-populate
with data from the appropriate data source tab. You’ll need to do this manually; see the next section.

Have New Rows in the Tables & Charts Tab Self-Populate with Data from a Data Source Tab
Choose a cell on your new row and enter “=” in the formula bar. Then click on the cell in the data source
tab that the data should be drawn from. See figure below. You will need to do this for each cell of the
new row.
In the example below, the formula for Cell A24 is “=YRBS!F3.” We entered “=” and then selected Cell F3
on the YRBS tab, where we had previously entered “2007” for the year of this data point. For Cell A25,
the formula will read “= YRBS!G3”; Cell A26’s formula will be “=YRBS!H3”, etc.
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Adjust Elements of Trend/Sparklines, Such As Axis Settings
The vertical axis of sparklines has been set to best represent the data shown in the CHIA Sample
Dashboard. If you’d like to change the maximum value of the vertical axis or another aspect of the
sparklines: Select a cell that contains a sparkline. For example, P4 on the YRBS tab, shown in the
selection box outlined in green below. Since this sparkline is part of a group of sparklines, all the
sparkline cells in the group will automatically be selected (selection box outlined in blue below). On the
ribbon at the top of your Excel screen, you should be in the Design tab, with Sparkline Tools highlighted
above the tab (circled in red below). This is where you can adjust elements of the sparklines, such as the
type of chart presented, sparkline color, and axis values.
To change axis values, click on the Axis icon, and from the drop-down menu, select “Custom Value” from
the section, “Vertical Axis Maximum Value Options” (see red arrow below).
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In the Sparkline Vertical Axis Setting window that pops up, type in the maximum value desired.
On the YRBS tab, shown below, we are dealing in percentages, so the maximum value of the vertical axis
of sparklines has been set at 100 (best practices dictate that minimum value is always 0). To change
the maximum value, enter it in the pop-up window titled Sparkline Vertical Axis Setting.
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Change or Add Conditional Formatting Rules
Don’t panic. It’s a bit time-consuming, but this advanced skill makes you feel like an Excel ninja.
Conditional formatting rules create the checkmarks and red and pink dots you see on the data source
tabs.

To Change the Checkmark Rule
For the YRBS, BRFSS Binge Drinkers, Hospitalizations Epi Report, and DFC or STOP Act tabs: Column E
creates a checkmark when the most recent data point (Column O on YRBS and DFC tabs, Column N on
BRFSS tab, and Column R on Hospitalizations tab) meets the objective in Columns B and C. Note that
the cell value in Column E equals the value of the most recent column of local data. However, to
streamline the viewing experience, the value is hidden (We’ll show you how to hide or unhide it in a
moment).
On the YRBS tab below, when Cell E4 is selected, you see in the formula bar that its value is =O4. The
value for Cell E5 =O5, etc. These values are not shown on the table; only the checkmark is visible in
Column E.
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Changing or adding conditional formatting rules that generate checkmarks is done one cell at a time.
Select Cell E4. In Excel 2013: on the Home tab at the top of the screen, click on Conditional Formatting
and choose Manage Rules from the drop-down menu. (See diagram below.)

A new window will pop up: the Conditional Formatting Rules Manager. Click on Edit Rule (circled in red
below). If Edit Rule is not an option because conditional formatting was not in place for this cell, click on
New Rule. The instructions below are the same for both new and edited rules.

User Guide: A Companion to the CHIA Dashboard v.1.1: May, 2017
Community Health Improvement in Action

www.wicommunityhealth.org

33

A new window opens: Edit Formatting Rule. For Rule Type, keep the default option, “Format all cells
based on their values.”
Under Rule Description:


For Format Style, choose Icon Sets. For Icon Style, choose any icon set from the drop down menu
for now; we will be making our own, as we only want a checkmark if the objective has been met,
and that is not a default option. Check the box marked “Show icon only” (see red circle in
example below). This is how you hide the value in this cell, showing only a checkmark for
objectives that have been met by the most recent data point. Displaying the value here wouldn’t
fit the column title “Objective Met?”, but if you want to display the value, simply make sure the
box marked “Show icon only” is unchecked.



Under “Display each icon according to these rules”, you will use this rule for all rows that have an
objective (Columns B and C) to Decrease to ## (Rows 4-7 and 9-10 on the YRBS tab; all rows on
other tabs that have an objective). For these rows, a higher number is worse.
o

For the first icon, choose “no cell icon” from the dropdown menu when value is (choose
“>”). Skip Value for now: first change Type to “Formula.” Then go back to Value, place
your cursor in the box for Value, and select the cell in Column C in the same row that you
are formatting. Because we are formatting E4 in this example, we’ll select Cell C4. You’ll
notice in our example that the Edit Formatting Rule pop up window is covering the cell we
want to select, C4, so we’ll need to either collapse or move the pop-up window:
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To collapse the pop-up window, click on the icon in the Value box (see red arrow in
depiction above). Once you’ve selected your cell (C4), you’ll need to click on the
icon in the collapsed window to expand it again.



To move the Edit Formatting Rule pop-up window over, simply click on any white
space in the window and drag the window over so you can select Cell C4.

Once you’ve selected C4, the value in the box will read =$C$4.
In the example below, we’ve collapsed the Edit Formatting Rule pop-up window so that we can click on
Cell C4. (We did that by clicking on the icon in the Value box on the expanded pop-up window, indicated
by the red arrow in the previous figure above.) To return to the expanded Edit Formatting Rule window,
click on the icon (see arrow below).

o

For the second icon, do the same: choose “no cell icon” when value is (choose “>”). Skip
Value for now: first change Type to “Formula.” Then go back to Value, place your cursor
in the box for Value, and select the same cell in Column C as you did for the first icon.
Again C4 in this example; the value in the box will read =$C$4.

o

For the third icon, choose the checkmark from the drop down menu. The rule
automatically generated is when <= formula. Your rule is now set: generate a checkmark
in E4 when the value in E4 (=O4, the most recent data point for this indicator in our
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example) is less than or equal to your objective for this indicator (C4).
Click on OK to exit the window. Then click OK to exit the Conditional Formatting Rules window.
Repeat for every cell with a similar rule/direction of objective:
 On the YRBS tab: E5, E6, E7, E9 and E10.
 On the BRFSS and Hospitalizations tabs: not applicable, as there is just one indicator.
 On the DFC tab: E5-E9
For the YRBS tab only: When formatting cell E8: under “Display each icon according to these rules,” you
will use the rule below, because the objective in Row 8 Columns B and C is to Increase to ## (i.e., for this
row, a higher number is better).


For the first icon, choose the checkmark when value is (choose “>=”). Skip Value for now: first
change Type to “Formula.” Then go back to Value, place your cursor in the box under Value, and
select the cell in Column C in the same row that you are formatting. Because we are formatting
E8 in this example, select cell C8. The value in the box will read =$C$8. This is your rule:
generate a checkmark in E4 when the value in E4 (=O4, the most recent data point for this
indicator) is greater than or equal to your objective for this indicator.



For the second icon, choose “no cell icon” when value is (choose “>=”). Skip Value for now: first
change Type to “Formula.” Then go back to Value, place your cursor in the box under Value, and
select the cell in Column C in the same row that you are formatting. Because we are formatting
E8 in this example, select cell C8. The value in the box will read =$C$8.



For the third icon, choose “no cell icon.” The rule automatically generated is when > formula.
Click on OK to exit the window. Then click OK to exit the Conditional Formatting Rules Manager.

Repeat for every cell with a similar rule. The original CHIA Dashboard has this rule only for cell E8, but if
you change objectives to “Increase to ##” for any other indicator, you will use this kind of rule.

To Change the Red Dot Rules that Compare Local to State and National Data (for all data source tabs
except Outlet Density)
In columns for state and national data, a red dot is automatically generated when the same year of local
data is worse. Depending on the data source tab, local data (for the same year as benchmark data) are
in different columns:


YRBS and DFC tabs: Statewide data is in Column R, national Data is in Column S, and local data
for the same year as benchmark data is in a hidden column, Q. (On the DFC tab, the first
indicator, Youth Current Drinkers, draws local, state, and national data from the YRBS tab. To the
best of our knowledge, state and national data are not available for the other DFC/STOP Act
indicators.) Since the benchmark year for the official paper-based YRBS may not be the same as
the most recent year of local Online YRBS data, it was not possible to link the red dot rule to a
36

column whose position would remain constant, so a hidden Column, Q, was added. If you have
not already done so, Unhide Column Q: select Columns P and R (do this by clicking on the P and R
all the way at the top of the spreadsheet), right click, then select Unhide. When you are finished
with changing conditional formatting rules for this tab, Hide Column Q again.


Binge Drinkers BRFSS and Arrests Epi Report tabs: Statewide data is in Column P, national Data
is in Column Q, and local data for the same year as benchmark data is in Column N. None of
these columns are hidden.



Hospitalizations Epi Report tab: Statewide data is in Column T and local data for the same year
as benchmark data is in Column R. None of these columns are hidden, and no national data is
available to the best of our knowledge.

Changing or adding conditional formatting rules that generate red dots is done one cell at a time. Select
the first cell in the column for state or national data. (For example, Cell R4 on the YRBS tab, shown
below.) In Excel 2013: on the Home tab at the top of the screen, click on Conditional Formatting and
choose Manage Rules from the drop-down menu. (See red circle below.)

A new window will pop up, the Conditional Formatting Rules Manager. Click on Edit Rule, circled in red
below. (Or, if Edit Rule is not an option because conditional formatting is not present for this cell, click on
New Rule).
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A new window opens: Edit Formatting Rule. For Rule Type, keep the default option, “Format all cells
based on their values.”
Under Rule Description:
 For Format Style, choose Icon Sets. For Icon Style, choose any icon set from the drop down menu
for now; we will be making our own, as we only want a red dot if the relevant local data (Cell Q4
in our YRBS example above) is worse than (i.e., greater than) the data in the cell we are
formatting (R4 in our example), and that is not a default option. Don’t check the box marked
“Show icon only,” as we want the value for the state or national figure to be displayed in this cell
along with an icon if the local data is worse.
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Under “Display each icon according to these rules,” you will use this rule for all cells (except R8
and S8 on the YRBS tab), since a higher number is worse for these rows.
o

For the first icon, choose “no cell icon” when value is (choose “>”). Skip Value for now:
first change Type to “Formula.” Then go back to Value, place your cursor in the box for
Value, and select the cell with the relevant local data. Because we are formatting R4 in
this example, we select cell Q4. In this example, the Edit Formatting Rule pop up box is
not covering the cell we want to select, Q4, so there is no need to collapse or move the
pop-up box. The value in the box will read =$Q$4.


If the pop-up box is covering the cell you want to select: you can select the cell
you want either by (1) clicking on the icon in the Value box (see red arrow in
depiction above) to collapse the Edit Formatting Rule pop-up box (you’ll need to
click on the icon in the collapsed box to expand it again); or (2) by moving the Edit
Formatting Rule pop-up box over so you can select the cell you want. For a
depiction of collapsing the pop up window and selecting a cell, see the section
above, Change the checkmark rule.

o

For the second icon, the steps are almost identical to the first: choose “no cell icon” when
value is (BUT here choose “>=”). Skip Value for now: first change Type to “Formula.” Then
go back to Value, place your cursor in the box for Value, and select the relevant cell for
local data. Because we are formatting R4 in this example, we’ll select cell Q4. The value
in the box will read =$Q$4.

o

For the third icon, choose the red dot (the rule automatically generated is when <
formula). Your rule for this cell is now set: generate a red dot in R4 when the value in R4
is less than (=better than) the local data for this indicator. In other words, a red dot is
generated when local data is worse.

o

Click on OK to exit the window. Then click OK to exit the Conditional Formatting Rules
Manager.

Repeat for every cell in the state and national columns, except for where this data is unavailable, and
except for Cells R8 and S8 on the YRBS tab.
When formatting cells R8 and S8 on the YRBS tab: under “Display each icon according to these rules,”
you will use this rule, because the objective in row 8 Columns B and C is to Increase to ## (i.e., for this
row, a higher number is better).


For the first icon, choose the red dot when value is (choose “>”). Skip Value for now: first change
Type to “Formula.” Then go back to Value, place your cursor in the box for Value, and select the
relevant cell for local data. Because we are formatting R8 in this example, we’ll select cell Q8.
The value in the box will read =$Q$8. This is your rule: generate a red dot in R8 when the value in
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R8 is greater than (= better than) the local data in Q8. In other words, the red dot is generated
when local data is worse than the state data.


For the second icon, choose “no cell icon” when value is (choose “>=”). Skip Value for now: first
change Type to “Formula.” Then go back to Value, place your cursor in the box for Value, and
select the same relevant cell for local data. Because we are formatting R8 in this example, we’ll
select cell Q8. The value in the box will read =$Q$8.



For the third icon, choose “no cell icon.” The rule automatically generated is when > formula.
Click on OK to exit the window. Then click OK to exit the Conditional Formatting Rules Manager.

Repeat for every cell with a similar rule (R8 and S8). The original CHIA Dashboard has this rule only for
cells R8 and S8, but if you change indicators (with objectives to “Increase to ##”; that is, for which a
higher number is better) you will use this kind of rule.

To Change the Pink and Red Dot Rules for Rank in State on the Outlet Density Tab:
Column U on the Outlet Density tab contains rankings for people per license and uses conditional
formatting to automatically generate a red or pink dot for the worst and second worst quartiles,
respectively. Rank is reported in the 2012 Density Reports (Table 11: Municipality Licenses/500 People
Rank within County and State), and (as of March 2017) is the most recent data for this indicator currently
available. Keep in mind that this rank is within Wisconsin, which in 2009 had the 9 th highest density of
people per license in the US (2012 Density Report, Appendix 1, Table 1). So even the “better”
municipalities in Wisconsin may compare poorly to the US average for alcohol outlet density.
How county rankings were calculated: Rank is among all 72 counties in Wisconsin. 1 has the most
dense concentration of alcohol outlets in state (i.e., fewest people per license, or "worst"). 72 has the
least dense concentration (most people per license, or "best"). To create the quartiles used to generate
red and pink dots, we took the total number of counties (72) and divided it into 4 quartiles:
 1 through 18: “Worst” quartile (densest in state) = Red Dot
 19 through 36: Second “worst” quartile (second densest in state) = Pink Dot
 37 through 54: Second “best” quartile (second least dense in state), no dot
 55 through 72: “Best” quartile (least dense in state), no dot
For municipality rankings: Rank is among all municipalities in Wisconsin that issued licenses in 2011-12:
1,618. 1 has most dense concentration of alcohol outlets in state (i.e., fewest people per license, or
"worst"); 1618 has the least dense concentration (most people per license, or "best"). To create the
quartiles, we took the total number of municipalities that issued licenses in 2011-12 (1,618), and
divided it into 4 quartiles:
 1 through 405: “Worst” quartile (densest in state) = Red Dot
 406 through 809: Second “worst” quartile (second densest in state) = Pink Dot
 810 through 1214: Second “best” quartile (second least dense in state), no dot
 1215 through 1618: “Best” quartile (least dense in state), no dot
40

About the conditional formatting used in Column U to generate pink and red dots: There should be no
need for you to edit the conditional formatting rules for this ranking data. If a more recent rank year is
available, we suggest keeping this column conditionally formatted as is: simply enter the more recent
rank data, remembering to change the date in the heading for this column as well, and pink and red dots
will be generated according to the rules set for 2011-12 data. Our rationale for maintaining the
formatting for future years of data: it is likely that the total number of municipalities in Wisconsin issuing
licenses will not change substantially, so the quartile limits will not change significantly. If a rank of
greater than 1,618 is reported for a municipality, the rule will no longer fit this cell and no dot will be
generated, but that is acceptable because no dot would be generated in any case for this “best” quartile.
If conditional formatting is lost, or for those of you who are curious, here are instructions on how to
conditionally format these cells.
Select the cell for county rank, U8. In Excel 2013: on the Home tab at the top of the screen, click on
Conditional Formatting and choose Manage Rules from the drop-down menu. A new window will pop up,
the Conditional Formatting Rules Manager. Click on Edit Rule (circled in red below). If this is not an
option because conditional formatting is not present for this cell, click on New Rule.

A new window opens: Edit Formatting Rule. For Rule Type, keep the default option, “Format all cells
based on their values.”
Under Rule Description:


For Format Style, choose Icon Sets. For Icon Style, choose any icon set from the drop down menu
for now; we will be making our own, as we want a plain red dot for the densest quartile and a
plain pink dot for the second densest, and this is not a default option. (Don’t check the box
marked “Show icon only,” as we want the value for rank to be displayed in this cell along with an
icon for the two densest quartiles. Leave the box unchecked, as shown below.)
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Under “Display each icon according to these rules,” you will use this rule for cell U8 only.
Remember, a lower rank is “worse,” meaning a higher density of alcohol outlets.
o

For the first icon, choose “no cell icon” when value is (choose “>=”). Skip Value for now:
first change Type to “Number.” Then go back to Value, place your cursor in the box for
Value, and enter 37. We want no cell icon when the rank is in the two “better” county
quartiles: a value >= 37.

o

For the second icon, choose the plain pink dot when value is (choose “>=”). Skip Value for
now: first change Type to “Number.” Then go back to Value, place your cursor in the box
for Value, and enter 19. We want a pink dot when the rank is in the second “worse”
county quartile, < 37 and >= 19.

o

For the third icon, choose the red dot. The rule automatically generated is when < 19.
We want a red dot when the rank is in the “worst” county quartile, <19.

Click on OK to exit the window. Then click OK to exit the Conditional Formatting Rules Manager.
For municipality ranks: select Cell U9. In Excel 2013: on the Home tab at the top of the screen, click on
Conditional Formatting and choose Manage Rules from the drop-down menu. A new window will pop up,
the Conditional Formatting Rules Manager. Click on Edit Rule (or, if this is not an option because
conditional formatting has been lost for this cell, click on New Rule). A new window opens. For Rule
Type, keep the default option, “Format all cells based on their values.”
Under Rule Description:
 For Format Style, choose Icon Sets. For Icon Style, choose any icon set from the drop down menu
for now; we will be making our own, as we want a plain red dot for the densest quartile and a
plain pink dot for the second densest, and this is not a default option. (Don’t check the box
marked “Show icon only,” as we want the value for rank to be displayed in this cell along with an
42

icon for the two densest quartiles. Leave the box unchecked, as shown below.)


Under “Display each icon according to these rules,” you will use this rule for Cell U9 and the
remainder of Column U (see below for a short cut to copy this rule to all other cells in the
column). Remember, a lower rank is “worse,” meaning a higher density of alcohol outlets.

o

For the first icon, choose “no cell icon” when value is (choose “>=”). Skip Value for now:
first change Type to “Number.” Then go back to Value, place your cursor in the box for
Value, and enter 810. We want no cell icon when the rank is in the two “better” quartiles:
a value >= 810.

o

For the second icon, choose the plain pink dot when value is (choose “>=”). Skip Value for
now: first change Type to “Number.” Then go back to Value, place your cursor in the box
for Value, and enter 406. We want a pink dot when the rank is in the second “worse”
quartile, <810 and >= 406.

o

For the third icon, choose the red dot. The rule automatically generated is when < 406.
We want a red dot when the rank is in the “worst” quartile, < 406.

Click on OK to exit this window, BUT don’t exit the Conditional Formatting Rules Manager yet. NOW,
HERE’S A REALLY GREAT SHORTCUT for applying this rule to the remainder of Column U: In the
Conditional Formatting Rules Manager, note the field under “applies to” and the table icon to the right of
this field. Click on the table icon (this collapses this pop-up window) and select all the cells in Column U
that you want this rule applied to: not Cell U8, as this is a county-level rank with different quartiles, but all
the other cells in Column U: U9 to the end of your data. Click on the table icon again to expand the popup window, and then on OK to exit the Conditional Formatting Rules Manager.
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Click on the icon (circled in red below) to collapse the Conditional Formatting Rules Manager window:

Now select all the cells in Column U that you want this rule applied to: U9 and below. Click on the table
icon (circled in red below) to expand the pop-up window, and then on OK to exit the Conditional
Formatting Rules Manager.
Your conditional formatting rule for municipal ranking now applies to all cells in Column U from U9 down.
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The tables and charts on the Tables & Charts tab are meant to be templates that can be used with many
types of data. Before you create your own table and chart from scratch for new data, try copying and
pasting one of the tables and charts and then linking your new chart to new data. Here’s how:
Select a table from the Tables & Charts tab that most closely resembles your new data. For example,
let’s say we want to create a chart on Youth Perception of Parental Attitudes towards Drinking. The
Youth Current Drinkers table is similar, so let’s copy and paste that.
Below, we’ve selected all the cells in the table Youth Current Drinkers. Right click and choose Copy from
the dropdown menu. (Or use Control-C.)

Then choose where you want to paste the table. We recommend you choose a blank section of the tab.
In the example below, we selected Cell Q21, to the right of the existing table and chart. Then we pasted
the table (either right-click and choose Paste or use Control-V).
Notice that on each table on the Tables & Charts tab, including this new table, there are hidden rows.
Here below, rows 27-32 are hidden. To Unhide rows, select rows before and after the hidden ones.
(Select Rows 26 and 33 in the example below; do this by clicking on the 26 and 33 headers all the way
to the left of the spreadsheet, circled in red below). Once selected, right click, and then select Unhide
from the dropdown menu.
The original table contained formulas that pulled data from the YRBS tab, and these are no longer valid
on our new table (hence all the zeroes in the example below). Since we are pulling data from another
part of the YRBS tab for the new table on Youth Perception of Parental Attitudes towards Drinking, let’s
update these formulas.
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To have the data for a cell drawn from another cell on a data source tab, choose a cell in your new table
and enter “=” in the formula bar, then click on the cell in the data source tab that the data should be
drawn from. You will need to do this for each cell of the new table.
In the example below, we selected Cell Q21. We entered “=” in the formula bar and then selected Cell A8
on the YRBS tab. The new formula for Cell Q21 is “=YRBS!A8”. For Cell Q24, the formula will read
“=YRBS!F3”; Cell A25’s formula will be “=YRBS!G3”, etc. The data points that are unused on the YRBS
tab auto populate with zeroes.
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Next, rehide the rows of data that are not in use. Select rows 27 through 32 in the example above, right
click, and choose Hide. Since we have no state benchmark data for this indicator, we will clear contents
of these cells. To do so, select Cells S23-S34, right click, and select Clear Contents. Our table is now
prepared:

Next, copy and paste the chart. We’ll choose the chart for Youth Current Drinkers, copying and pasting it
to the right of the new table. We’ll need to connect this new chart to the data on the new table.
Right click on the chart plot area of your new chart (in the space around the bars of data, not on the bars
themselves) and choose “Select Data” from the drop down menu (circled in red below).

On the Select Data Source window that pops up, under Legend Entries (Series), select the first series and
click on Edit (circled in red below).
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On the Edit Series window that opens: under Series Name, choose the cell on your new table that names
this series of data. (In the example below, My parents would disapprove of me drinking). Note that I had
to move the Edit Series window over so that I could choose the appropriate cell, Q21.

Under Series Values, click on the icon to select cells from the table. This collapses the Edit Series
window. Again, you may need to move the window over to select the data cells from your table (including
those shaded cells if needed for the benchmark line). In the example below, we have no state
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benchmark data, so we selected Cells R24 through R33. Click on the icon again to expand the window,
then click on OK to exit the Edit Series window.

If needed, do the same to edit the second series, the benchmark data. In our example, we have no
benchmark data, so we will remove the second series (select it and then Remove, circled in red below).

Next, to edit the years, in the Select Data Source window under Horizontal (Category) axis labels, select
Edit. On the Axis Labels window that opens, select the cells for years from your new table (as depicted
below), plus the shaded rows before and after those years if your data contains a benchmark line. Click
OK to exit the Axis Labels window and OK to exit the Select Data Source window.
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Now your new table and chart are linked. You’ll need to do some reformatting of the chart’s colors,
labels, and title: see the Format Chart section below for instructions.

To create a chart from scratch in the same style as these templates:
Create a table of data. Then select the local data to be displayed in the chart. For example, on the first
table, Youth Current Drinkers, we’d select cells B24-B33.
Insert a column chart: in Excel 2013, go to the Insert tab at the top of the screen (circled in red below).
Choose the column chart icon from the Chart menu (in the top center of the screen, circled in red below),
then choose the first option in the dropdown menu (circled in red below).
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If the chart that opens is on top of your data, move the chart over: click anywhere on the chart and drag it
to where you want it.
Add benchmark (e.g., state average) data:
Right click on the chart plot area (in the space
around the bars of data, not on the bars
themselves) and choose “Select Data” from
the drop down menu (circled in red on the
diagram to the right).

On the Select Data Source window, under Legend Entries (Series), choose Add (circled in red below).

On the Edit Series window that opens: under Series Name, choose cell C4 (State Average). Under Series
Values, click on the icon to collapse the pop-up window and select cells from the table. In this example,
we’d select cells C23-C34.
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Click on OK to exit the Edit Series window. Stay in the Select Data Source window for the next step.
Add the years on your X-axis: In the Select Data Source window, under Horizontal (category) axis labels,
select Edit (circled in red below).

On the Axis Labels window that opens, click on the icon to collapse the pop-up window and select the
years from your table, plus the rows before and after those years if you have a benchmark line (Cells
A23-A34 in our example below).
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Click on the icon to expand the pop-up window, then on OK to exit the Axis Labels window. Stay in the
Select Data Source window for the next step.
Make your local data line up with the correct year (adding those blank years has thrown it off): under
Legend Entries (Series), choose Series 1 and click on Edit (circled in red below).

On the Edit Series window that opens: ignore Series Name. Under Series Values, click on the icon to
collapse the pop-up window and select cells from the table. In this example, we’d select cells B23-B34
(including the shaded cells). Click on the icon to expand the pop-up window, then OK to exit the Edit
Series window, and OK to exit the Select Data Source window.
Turn your benchmark data
into a line: on your chart,
select the columns of data
that show the state average
by clicking once on one of
the columns (all of them
should be selected with
when one is clicked on
once).
Right click, and choose
Change Series Chart Type
from the dropdown menu
(circled in red on the
diagram to the right).
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At the bottom of the Change Chart Type window that opens, find “State Average” under series name.
Choose the first icon for line chart, circled in red below. (Leave Series 1 as a clustered column chart.)
Click OK to exit. You now have a benchmark line for statewide data. You’ll need to format the style of
your new chart; see the next section for details.
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Format Chart Style:
Make the data columns straw-colored with no border and wide. Select the columns of local data by
clicking on one of them. (Just click once. If you click twice, you’ll select just one column. Then you’ll
need to unselect it by clicking somewhere else on the chart, and then try again.) Right click and choose
Format Data Series. The Format Data Series window opens to the side. Click on the bucket icon near
the top of this window, then click on FILL to expand the menu. Select Solid fill. To choose the straw
color: on the FILL menu, click on the bucket icon to the right of “Color” to open the color palette. Select
More Colors (circled in red below).

Click on the custom tab of the Colors window. Select RGB for Color Model and enter this RGB code: Red:
223; Green: 204; Blue: 116. Click OK to exit the Colors window.
Still in the paint bucket tab of the Format Data Series window, click on Border and select “no line”. This
removes the blue outline around the columns of data.
Make the columns wider, click on the third tab of the Format Data Series window, the columns icon.
Decrease the Gap Width to 80% (circled in red below). Exit the Format Data Series window by clicking on
the X in the upper right corner.
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Add labels to your data columns: Select the columns of local data by clicking on one of them. Right
click, choose Add Data Labels (selected below), and then again on the menu that opens to the side,
choose Add Data Labels. [Note the plural: if the menu says “Add Data Label,” you’ve selected just one
column by accident (likely by clicking on it twice). Unselect it by clicking on a different part of the chart,
then click again (just once) on a column to select them all.]
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Labels have been added to your chart. The default is to have these labels outside the columns. Some
say this distorts the data by making the columns look taller than they are. To change the placement of
the data labels, select the data labels by clicking once on one of them. (If you double click, just one
column will be selected, and you’ll need to unselect it by clicking on another part of the chart and then
trying again.) Right click, then select Format Data Labels (circled in red below).

The Format Data Labels window opens to the side. On it, under label position, select Inside End (circled
in red below). Exit the Format Data Labels window

User Guide: A Companion to the CHIA Dashboard v.1.1: May, 2017
Community Health Improvement in Action

www.wicommunityhealth.org

57

Format the font for data labels on columns. Select all data labels for your columns by clicking on one.
On the Home tab at the top of your screen, change the font to Corbel and the font size to 10.5. Change
the font color to dark gray. Note: The CHIA Dashboard uses Corbel because it is a nice looking sans serif
font that comes standard with all versions of Microsoft Office. However, we strongly recommend an
alternate condensed font, such as Franklin Gothic Condensed (available for free download online at
http://fontsgeek.com/fonts/Franklin-Gothic-Std-Condensed, click on ZIP download, then open the downloaded
file and click on Install). If you choose a different font, stay away from Arial or Calibri, as these are
overused and can make your work look boring.
Format the benchmark line’s color. Select all data points on the benchmark line by right clicking once on
one of them. (If you click twice, you will mistakenly select just one data label). Choose Format Data
Series from the dropdown menu. The Format Data Series window opens to the side. Click on the color
bucket, then click on FILL. To choose the burnt orange color: click on the bucket icon (to the right of
Color on the FILL menu). Select More Colors at the bottom of the color palette that opens. Click on the
custom tab. Choose RGB as the Color Mode and enter this RGB code: Red: 190; Green: 81; Blue: 8. Click
OK to exit, then exit the Format Data Series window.
Add a name label to the first point on your benchmark line. Click on the benchmark line (all points will be
selected), then click on just the left-most data point to select just this point. Right click, choose Add Data
58

Label, and on the dropdown menu that opens to the side, select Add Data Label again. [Note the singular
(not Labels). If plural, go back and click on just the one data point again to select only the one.]
The default is to have this label be a value to the right of the data point. To change that, select the data
label (currently a number value) by clicking on it twice, right click, then select Format Data Label (note
the singular). The Format Data Label window opens to the side. On it, on the Label Position tab (the
columns icon), under Label Options, select Series Name and de-select value. Make sure “Show leader
lines” is unchecked. Under Label Position, choose Left. (See example below). Exit the Format Data
Labels window.

With that data label still selected, on the Home tab, change the data label font to Corbel size 10.5 and
change the font color to burnt orange (that color should now show up on the color options bar as recently
selected, or see RGB code in the part above on formatting the benchmark line’s color).
Add a value label to the last point on your benchmark line. Click once on the benchmark line (all points
will be selected), then click on just the right-most point. Now just this point will be selected. Right click,
choose Add Data Label, then again Add Data Label. To change the position of the label, select the data
label by clicking on it, right click, then select Format Data Label. The Format Data Label window opens
to the side. On it, on the Label Position tab (the columns icon), under Label Position, choose Right. Exit
the Format Data Labels window. With that data label still selected, change its font to Corbel 10.5 and its
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color to burnt orange (that color should now show up on the color options bar as recently selected, or see
RGB code in the part above on formatting the benchmark line’s color).
Simplify the chart’s look so that viewers can focus on the data. This is best practice for data visualization.
Delete the following by selecting it, right clicking, and choosing delete:
 The vertical y-axis
 The major gridlines (they run horizontally at regular intervals through the plot area, see example
below)
 If working in Excel 2013: the chart title. Because of a quirk of Excel 2013, chart titles cannot be
resized, so we insert a text box instead. To do so, click on the chart plot area, go to the Insert tab
at the top of your screen, and select text box. Format the box so it has no border line and no fill
color. Add a descriptive title (see next section).

Add a one-sentence title that describes what the data is saying. For more on this, see
http://stephanieevergreen.com/how-to-rock-the-text-in-your-data-visualization/. In Excel 2013, title boxes
cannot be resized or moved. Use this workaround: delete the title box and insert a text box (Select Text
Box on the Insert tab). Format the title: Corbel size 12, bold, dark gray color.
Format the x-axis. Click on the horizontal axis of years. Change font to Corbel 10 and the color to dark
gray.
Resize the plot area. Depending on your chart, you may need to resize the plot area so that all the
elements fit and are aligned with other charts on your dashboard. To do so, click on the chart’s plot area
so that a box appears outlining its shape. Drag one of the handles (bubbles in the middle of each line)
down, up, or sideways to resize. You’ll need to keep the plot area consistent across charts: the
benchmarks should all start at about the same position on the page, and the maximum vertical axis
value should also be consistent.
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In the example below, the plot area is outlined. It has been resized: we pulled the top handle down so
that the title fit, and pulled the left side handle to the right so that the label State Average fits.

If needed, change the placement of data labels so they can be clearly seen. Sometimes, the benchmark
line is right on top of the local data label. To move it slightly up or down, double click on the data label
and drag it a few millimeters to a new place.
Copy the chart and paste it to the dashboard or another document. Right click on the chart, making sure
the whole chart is selected, and select copy. Go to the Dashboard tab and paste it to your desired
location (right click, paste). Make sure any added chart elements have been copied, especially shapes,
like the arrow used in the sources of alcohol for youth chart; you may need to copy and paste these
separately. For a clean look on your Dashboard tab, remove the border from the chart by selecting the
chart, right click, and select Format Chart Area. On the paint bucket tab of the Format Chart Area
window, under Border, select No Line.
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About the Youth Risk Behavior Survey (YRBS)
The YRBS survey is used to produce statistics in a variety of areas related to young people's health,
including, for example:












depression
suicidal ideation
alcohol, tobacco and other drug use
sexual behavior
homelessness and housing instability
bullying and harassment
experiencing violence
sleep
exercise
nutrition
social connectedness

These risk behaviors result in the most significant causes of both mortality and morbidity during youth
and adulthood.

Advocating for YRBS
Do your community's middle and high schools implement the YRBS? If not, advocate for its use both
online (Wisconsin Online YRBS, for both middle and high schools) and, if selected by the Centers for
Disease Control and Prevention (CDC), as a sample high school for the state (official paper-based
Wisconsin YRBS, high school only). The Wisconsin Department of Instruction (WI DPI,
http://dpi.wi.gov/sspw/yrbs) has a template letter of support to send to a school principal in the event
your high school is selected for the state sample (WI YRBS).
To advocate for either the online YRBS or the official paper-based WI YRBS, talk to school administrators
about the importance of this data to your coalition's efforts. YRBS data can help guide the assessment
and prioritization of needs, the choice of appropriate interventions, the evaluation of efforts, and the
securing of funding and community support. Collect stories from others: how does YRBS data help other
community efforts? If possible, show school administrators publications in which YRBS data is
used (consider the health department’s community health assessment and community health
improvement plan, the hospital’s community health needs assessment, and coalition documents and
websites). Finally, stress that the YRBS is the only free survey of youth risk behavior that provides the
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opportunity for comparing local data to state and national figures. However, use caution when
comparing local data to state and national rates: note that the survey methodologies are different when
comparing local Online YRBS data to state and national figures that use official paper-based YRBS
surveys in a representative sample of high schools selected.

The Online YRBS: for Local Data
Looking for a way to assess your students' safety and health behavior? A free
service for Wisconsin school districts and their community partners.
Wisconsin school districts, private schools, tribes, CESAs, and county agencies (i.e.,
public health, human services, 51.42 boards) can use the Wisconsin Online Youth
Risk Behavior Survey (OYRBS) system to gather local student self-reported data on
health behaviors, attitudes and perceptions, and protective factors. These data can
help raise awareness of important health issues, influence societal norms and
perceptions, show the need for funding, and capture the need for, and monitor the
impact of, prevention programs for school-aged youth.
- Wisconsin Department of Instruction website
Each school can choose the questions asked on their Online YRBS. Your coalition may want to advocate
for the state's current standard set of alcohol-related questions so local data can be compared at the
state and national levels (most of the alcohol-related questions asked in the official state survey mirror
those asked on the official national survey).
Your coalition may also need to take steps to have access to data at the school and/or county level.
Many schools are not comfortable with sharing their school-specific YRBS data with an outside agency,
but are open to having their data aggregated with that of other schools in the county that implement the
Online YRBS. WI DPI or your local CESA office may be able to help advocate for the YRBS and/or assist
with data aggregation. If you are working with schools individually to advocate for the sharing of
countywide Online YRBS data, offer to sign a written MOU about how data will be shared (e.g., only
countywide data will be shared with coalition members and the public; school-specific data will not be
shared).
Frequency: Schools can choose to implement the Online YRBS at intervals of their choosing. Some
Wisconsin schools conduct the survey every year, and some every other year. You may want to advocate
for timing the online survey as close as possible to the official Wisconsin paper-based YRBS sample (see
section below) to achieve more comparable results.
Geographic Levels: School-level. School district and aggregated county data may be available locally.
See above for tips on how to advocate.
Demographic Categories: Grade level, age, gender, race/ethnicity, and other factors.
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Strengths: YRBS data can be broken down by grade level, gender, race/ethnicity, and other factors.
Limitations: Data may not be weighted at the school or county level. (State and national data are
weighted.) The Online YRBS is a school-based survey, so students who have dropped out of school are
not represented. It is also subject to bias due to self-report, non-coverage (refusal by schools to
participate), and non-response (refusal/no answer). Estimates for some subgroups may have relatively
low precision (i.e., large confidence intervals).

The Official Paper-Based YRBS: for State and National data
The Wisconsin Youth Risk Behavior Survey (WI YRBS) is a paper-based survey conducted by the WI DPI
as part of a national effort by the CDC. The WI YRBS is conducted every two years (in odd-numbered
years) in a random sample of public high schools chosen by the CDC. This survey provides official
statewide statistics, not local-level data. Results from the Online YRBS, used for local level data, are not
aggregated at the state level. Because of the different survey methodologies used at the local and
state/national levels, proceed with caution when making comparisons.
Source of Wisconsin YRBS data: download Summary Table at http://dpi.wi.gov/sspw/yrbs.
Source of National YRBS data: http://www.cdc.gov/healthyyouth/data/yrbs/index.htm
Frequency: Biennial, however, weighted data is not always achieved at state level.
Geographic Levels: National & State. (School district and aggregated county data may be available
locally for the Online YRBS-- see section above.)
Demographic Categories: Grade level, age, gender, race/ethnicity, and other factors.
Strengths: YRBS data can be broken down by grade level, gender, race/ethnicity, and other factors.
Limitations: Weighted representative samples are not available for all states. (For example, Wisconsin
did not achieve weighted data in 2015 because too many schools selected by the CDC for the state
sample refused to participate.) YRBS is a school-based survey, so students who have dropped out of
school are not represented. It is also subject to bias due to self-report, non-coverage (refusal by selected
schools to participate), and non-response (refusal/no answer). Estimates for some subgroups may have
relatively low precision (i.e., large confidence intervals).

About the Behavioral Risk Factor Surveillance System (BRFSS)
The Behavioral Risk Factor Surveillance System (BRFSS) is the nation's premier system of health-related
telephone surveys that collect state data about U.S. adult residents regarding their health-related risk
behaviors, chronic health conditions, and use of preventive services. For larger geographical areas, data
can be stratified by age (starting with the range of 18-24), gender, employment status, education,
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race/ethnicity, and other factors. BRFSS data are weighted to represent the state's non-institutionalized
adult population ages 18 and older.
Starting with 2011, BRFSS began including both landline and cell phone interviews, obtained from
separate samples and later combined and weighted by the U.S. Centers for Disease Control and
Prevention (CDC). Prior to 2011, only landline telephone numbers were sampled. Estimates using
combined landline and cell phone BRFSS data from 2011 and forward should not be directly compared
to estimates from earlier years, when only landlines were used.
Binge drinking data at the levels of state, county, and City of Milwaukee are available by WISH
(Wisconsin Interactive Statistics on Health) query: https://www.dhs.wisconsin.gov/wish/brfs/form.htm.
Use the Trend Module (this module includes only topics that have appeared in the survey since 2000).

Instructions for using the Trend Module to get binge drinking data:


Step 1: Choose a topic: binge drinking.



Step 2: Choose age-adjusted results (for a more accurate comparison of your data with other
geographic regions).



Step 3: Choose Geographic Areas as a column variable.



Step 4: Choose Survey Years. IMPORTANT: For results on smaller counties, you must select
multiple years of data (hold down the control key and select the desired years). All counties in
Wisconsin are represented in query results when 3 years -- e.g., 2014, 2013 and 2012-- are all
selected. For larger counties, data may be available annually or in two-year periods. Experiment
to get the best data for your area. The BRFSS tab has 9 columns available for entering local data
(Columns F through N, with most of these hidden; see the section Enter Your Data for instructions
for unhiding columns).



Step 5: Choose a Geographic Area.
o For local data, select "County" and then choose one or more counties. (Or select
“Milwaukee” and then choose city and/or surrounding area.)
o Select "Statewide" for the Wisconsin average.

Source of National BRFSS data: by query at http://www.cdc.gov/brfss/brfssprevalence/. You must
formulate the US average (click on cell Q4 to see formula).
County Health Rankings and Roadmaps provides a concise synopsis of the strengths and limitations of
BRFSS data (http://www.countyhealthrankings.org/measure/excessive-drinking):

User Guide: A Companion to the CHIA Dashboard v.1.1: May, 2017
Community Health Improvement in Action

www.wicommunityhealth.org

65

A study evaluating the reliability and validity of the self-reported BRFSS measures found the
reliability (repeatability) of the BRFSS alcohol consumption data to be high. Validity (accurate
representation) was found to be moderate but sufficient given the difficulty in assessing the
validity of people’s reports of their own alcohol use. Using self-reported survey data to assess
excessive drinking has limitations: First, excessive drinking is often underreported in surveys
because of recall bias, social desirability response bias, and non-response bias. Second, BRFSS
changed the definition of excessive drinking for women in 2006; this means that there will be a
higher prevalence in recent years compared to prior years for women. Third, the measure does
not include youth drinking prevalence. Some US states and counties administer a Youth
Behavioral Risk Surveillance Survey, but there is not adequate coverage or consistent enough
methodology to aggregate the results to represent all counties across the country. Binge drinking
accounts for 90% of alcohol consumption for youth ages 12-17. Having a measure that includes
youth binge drinking would be beneficial for understanding youth drinking patterns in different
counties.

About the Epi Report (Wisconsin Epidemiological Profile on Alcohol and Other
Drug Use): used on the Arrests Epi Report tab: OWI and Liquor Law Arrests; and
the Hospitalizations Epi Report tab: Alcohol-Related Hospitalizations
The Wisconsin Epidemiological Profile on Alcohol and Other Drugs is a compilation of
alcohol and other drug use data from various sources. From each data source, it presents
the most recent available year of data, as well as trend information for previous years and
U.S. comparisons when available. County-level data tables are included to assist in
developing local needs assessments and evaluations.
– Executive Summary, 2016
The Epi report has been published every two years since 2008 and is available at:
https://www.dhs.wisconsin.gov/stats/aoda.htm. These reports are prepared by the Division of Care and
Treatment Services, University of Wisconsin Population Health Institute, and the Division of Public Health,
with funding provided by the U.S. Substance Abuse and Mental Health Services Administration
(SAMHSA).

Arrests Epi Report tab
OWI and Liquor Law Arrests: Rate per 100,000 population
Operating a Motor Vehicle While Intoxicated (OWI) is defined as having a Blood Alcohol
Concentration (BAC) of .08 or greater. … Wisconsin is the only state where the first OWI
offense is a traffic violation. The first OWI offense is only criminalized if the driver is
convicted of causing injury or death while operating while intoxicated or if a person under
age 16 is present in the vehicle. Nevertheless, Wisconsin has 1.2 times the national rate of
OWI arrests, and 2.9 times the national rate of other liquor law violations. …
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According to the Wisconsin Department of Justice, liquor law violations are “violations of
state or local laws or ordinances prohibiting the manufacture, sale, purchase,
transportation, possession, or use of alcoholic beverages, not including driving under the
influence and drunkenness.”
- Wisconsin Epidemiological Profile on Alcohol and Other Drug Use, 2016, p. 30-31.
Data Source for the Arrests Epi Report tab: as reported in Wisconsin Epidemiological Profile on Alcohol
and Other Drug Use ("Epi Report"), 2016, 2014, 2012, 2010, and 2008:
https://www.dhs.wisconsin.gov/stats/aoda.htm.


For county and state rates, see Table: Operating a motor vehicle while intoxicated (OWI) and
liquor law arrests, rate per 100,000 population, Wisconsin by county.
More recent data may be available from local law enforcement agencies and/or Arrests in
Wisconsin, an annual report by the Wisconsin Department of Justice:
https://wilenet.org/html/justice-programs/programs/justice-stats/library.htm with population
data from Wisconsin Interactive Statistics on Health (WISH) population module:
https://www.dhs.wisconsin.gov/wish/population/index.htm.
It is important to talk to local law enforcement leaders about how to interpret changes in arrest
rates. A lower arrest rate could be caused by less problem behavior or less enforcement, for
example.



For national rates, see Figure 10. Arrests (adult and juvenile) for operating a motor vehicle while
intoxicated (OWI), rate per 100,000 population, Wisconsin and the U.S. and Figure 11. Liquor law
arrests (adult and juvenile), rate per 100,000 population, Wisconsin and the U.S.

Data source for the 2016 Epi Report: Wisconsin Uniform Crime Reporting (UCR) Data Dashboard Center,
Bureau of Justice Information and Analysis (BJIA), Wisconsin Department of Justice. Note: Wisconsin
Department of Natural Resources and Division of State Patrol crime data are included in the statewide
total, and are not included in specific counties.
Data source for previous Epi Reports: Arrests in Wisconsin, 2005 to 2012. Statewide rate calculations
include arrests not identified by county. Arrests in Wisconsin, an annual report by the Wisconsin
Department of Justice, provides numbers of arrests among adults and juveniles at the state and county
levels (https://wilenet.org/html/justice-programs/programs/justice-stats/library.htm). According to the
Epi Report (2016), 18% of all liquor law arrests in Wisconsin were of juveniles in 2014.
The Epi Report uses population estimates from the Wisconsin Department of Health Services, Office of
Health Informatics. Available from the Wisconsin Interactive Statistics on Health (WISH) population
module: https://www.dhs.wisconsin.gov/wish/population/index.htm.
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Note: More recent local data may be available from local law enforcement agencies, and again, it is
critical to talk to local law enforcement leaders about how to interpret changes in arrest rates.

Hospitalizations Epi Report tab
Estimated Rate of Alcohol-Related Hospitalizations: Rate per 100,000 population
Data Source: Estimates reported in Wisconsin Epidemiological Profile on Alcohol and Other Drug Use
("Epi Report"), 2016, 2014, 2012, 2010, and 2008. Table: Alcohol-related hospitalizations, total number
and rate per 100,000 population, Wisconsin by county. Epi Reports available at:
https://www.dhs.wisconsin.gov/stats/aoda.htm.
For this estimate of alcohol-related hospitalizations, the Epi Report uses 1) Wisconsin hospital inpatient
discharge database, Office of Health Informatics, Division of Public Health, Wisconsin Department of
Health Services, and 2) the Alcohol-Related Disease Impact (ARDI) specifications from the CDC (see
https://nccd.cdc.gov/DPH_ARDI/default/default.aspx). The ARDI specifications define 54 conditions or
groups of conditions and associate each with a distinct fraction of cases attributable to alcohol. Staff
from the Office of Health Informatics used the ARDI specifications to identify hospitalizations for these
conditions with the ICD-9-CM codes specifying the principal diagnosis and the first eight other reported
diagnoses. Total alcohol-attributable hospitalizations were then estimated by multiplying the number for
each condition by the associated alcohol-attributable fraction and summing over conditions. [ICD-9 is the
9th revision of the International Classification of Diseases system defined by the World Health
Organization. The clinical modification (CM) or ICD-9, or ICD-9-CM, for use in hospitalization diagnosis
coding, is defined by the US Centers for Medicaid Services and updated annually.]
The Epi Report uses population estimates from the Wisconsin Department of Health Services, Office of
Health Informatics. Available from the Wisconsin Interactive Statistics on Health (WISH) population
module: https://www.dhs.wisconsin.gov/wish/population/index.htm .
Hospitalization numbers and rates are based on patient's county of residence.
Note that Wisconsin Public Health Profiles (https://www.dhs.wisconsin.gov/stats/pubhealthprofiles.htm) reports on alcohol-related hospitalizations using ONLY data from the Wisconsin hospital
inpatient discharge database (Office of Health Informatics, Division of Public Health, Wisconsin
Department of Health Services). Alcohol-related hospitalizations on the Public Health Profiles are broken
down by age group (18-44; 45-64); average length of stay and cost are also provided. However, in the
Wisconsin Public Health Profiles, diagnostic definitions used for the categories are based on the principal
diagnosis. That is, an alcohol-related diagnosis (Alcohol psychoses, Alcohol dependence syndrome,
Alcohol abuse, Alcoholic polyneuropathy, Alcoholic cardiomyopathy, Alcoholic gastritis, Chronic liver
disease and cirrhosis, or Excessive blood level of alcohol) must be the principal diagnosis for the
hospitalization to be categorized as alcohol-related. The Public Health Profiles do not provide estimates
for alcohol-attributable hospitalizations that do not have an alcohol-related principal diagnosis. For
example, a hospitalization due to a fall injury would likely have a primary diagnosis of injury, and not be
categorized as alcohol-related, even if alcohol was involved. The Alcohol-Related Disease Impact (ARDI)
specifications from the CDC estimate that 32% of all fall deaths are attributable to alcohol.
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Outlet Density tab
Municipal clerks annually report the number of alcohol licenses to the Wisconsin Department of Revenue
(DOR). The Outlet Density tab uses three main data sources: DOR data as reported in county-specific
2012 Density Reports; compilations of local DOR 2015-6 licensing data maintained by Julia Sherman of
the Wisconsin Alcohol Policy Project; and local population estimates from the Wisconsin Department of
Administration, Demographic Services Center. Due to differences in how DOR data was compiled, there
may be discrepancies between the 2012 Density Reports and more recent data.
For 2007-2012 data: Wisconsin County Alcohol Outlet Density Reports, Alcohol License Overview for ###
County, 2012. Here called “Density Reports,” these were a joint project of the Wisconsin Department of
Health Services and the Wisconsin Alcohol Policy Project. Each county report lists alcohol outlet density
by municipality using Department of Revenue data. Strategies for addressing outlet density are also
suggested. As of March, 2017, there are no plans to publish reports in this format in 2017. The 2012
reports are available at: https://www.dhs.wisconsin.gov/aoda/alcdensity.htm.
For 2015-16 licensing data: Department of Revenue data compiled by municipality and county by Julia
Sherman, coordinator of the Wisconsin Alcohol Policy Project: 608-262-0370 or julia.sherman@wisc.edu.
For 2015-16 population data: The Wisconsin Department of Administration, Demographic Services
Center annually produces population estimates for Wisconsin counties and municipalities, available at
http://www.doa.wi.gov/divisions/intergovernmental-relations/demographic-services-center/estimates.
For state and national figures on People per License and Licenses per 500 People in Columns V, W, AC,
and AD: The Fact Book 2013 (The Beverage Information Group), pages 12-13 reports on total number of
licenses. More recent state and national data may be available. The Fact Book is an annual publication,
but the 2016 edition costs $525 to purchase: https://beverage-handbookstore.myshopify.com/products/2016-fact-book?variant=12903981700. State and national population
estimates are from the U.S. Census. Since every state licenses alcohol differently, national figures and
comparisons across states can be problematic.
Alcohol outlet density is just one measure of the retail availability of alcohol. For on-premises locations
(class B), the occupancy of each establishment is another important factor. For off-premises, shelf space
devoted to alcohol is another indicator.
Unlike other data source tabs on the dashboard, no sample objectives are offered on the Outlet Density
tab, as each coalition will need to determine the municipality/ies on which to focus licensing efforts and
an appropriate objective, depending on local conditions.
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DFC or STOP Act tab
Drug-Free Communities Support Program (DFC) Alcohol-Related Core Measures (2016)
The 2016 DFC and STOP Act Core Measures provided on this tab are for informational purposes only. If
awarded a DFC or STOP Act grant, you'll be required to track the measures specified by the grant at that
time and submit your indicators and survey questions to the DFC evaluator for approval.
The Drug-Free Communities Support Program (DFC) is a Federal grant program that provides funding to
community-based coalitions that organize to prevent youth substance use. Current or former DFC
grantee communities can also apply for a Sober Truth on Preventing Underage Drinking Act (STOP Act)
grant. The purpose of the STOP Act grant program is to prevent and reduce alcohol use among youth
ages 12-20.
Note that only one measure, Youth 30 Day Use, correlates to data provided by one of the sources used on
the Dashboard. Cells in Row 4, including in hidden Columns I through N, pull data from the YRBS tab.
Note that headers are not pulled from the YRBS tab and may need to be adjusted.

CHIA is a joint collaboration of the Wisconsin Association of Local Health Departments and Boards
(WALHDAB) and the UW Population Health Institute. CHIA is funded by a grant from the UW School of
Medicine and Public Health from the Wisconsin Partnership Program. For more information, visit
www.wicommunityhealth.org.
The CHIA Strategy Map was created in collaboration with a committee of subject matter experts who
provided guidance and feedback:









Annie Short, Grant Manager, North East Wisconsin Area Health Education Center
Beth Scheelk, Public Health Educator, WI DHS/Division of Public Health, NE Region Office of
Policy and Practice Alignment (OPPA)Team
Cynthia DiCamelli, Co-Chairperson, Oregon CARES
Dorothy Chaney, Regional Coordinator, Alliance for Wisconsin Youth Southern Region and
Northeastern Wisconsin Area Health Education Center
Heidi Keating, Public Health Planner, Winnebago County Public Health
Kathy Comeau, Project Coordinator, Better Brodhead
Libby Holte, Public Health Educator with the Sheboygan County Division of Public Health
Philip Duket, North East Regional Coordinator for the Alliance for Wisconsin Youth, NEWAHEC

In addition, feedback on the beta version of the dashboard (released in October of 2016) was provided by
a core group of 20 CHIA partner communities, representing Alcohol and Other Drug coalitions from the
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following Wisconsin locations: Barron County, Brown County, Calumet County, Clark County, City of
Cudahy, Eau Claire City/County, Florence County, Fond du Lac County, Green Lake County, Iowa County,
Marinette County, Marquette County, Oneida County, Outagamie County, Pepin County, Polk County,
Portage County, Sawyer County, Winnebago County, and Wood County.
For feedback and questions on the CHIA Sample Dashboard, please contact Sara Jesse, CHIA Project
Manager, at sara.jesse@badgerbay.co or 608-432-3042; or contact WALHDAB at
WALHDAB@badgerbay.co or 920-560-5635.

Suggested Citation
Please attribute CHIA in all versions of the dashboard you create. Suggested citation:
Sample Dashboard for Measuring the Progress and Impact of Alcohol-Related Initiatives,
2017. Available at www.wicommunityhealth.org. Created by Community Health
Improvement in Action (CHIA), a project of the Wisconsin Association of Local Health
Departments and Boards, 2014-2017, and funded by a grant from the University of
Wisconsin School of Medicine and Public Health through the Wisconsin Partnership
Program.
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